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How to Find Help
This manual is your first step for I-SWIS support. Can’t find the 

information you need? Contact your I-SWIS Facilitator.

My I-SWIS Facilitator Information

Facilitator Name: 	

Phone Number: 	

Email Address: 	

For More Information
Are you still stuck? Visit the PBISApps support website online at

support.pbisapps.org
There you will find answers to many common questions, a search-

able knowledge base and discussion forum, and ways to contact 

PBISApps to ask your question directly.
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Overview
Who Should Use this Manual? 
The I-SWIS User’s Manual is to provide I-SWIS users a quick refer-

ence and trouble-shooting guide. The manual is for use by I-SWIS 

facilitators and I-SWIS users during initial start-up, training, and 

ongoing use. Much of the information found in this manual is also 

available online at www.pbisapps.org. 

What is PBISApps? 
PBISApps is a not-for-profit group, developed and operated by 

Educational and Community Supports (ECS), a research unit at 

the University of Oregon. The PBISApps team manages a series 

of educational tools related to the implementation of multi-tiered 

systems of support (MTSS). These tools include the School-Wide 

Information System (SWIS) Suite, PBIS Assessment, and PBIS 

Evaluation. These applications have been implemented in more 

than 25,000 schools in the US and abroad. PBISApps has been 

making schools safer and more productive places for over 10 years 

by empowering educators to make data-based decisions as 

problems emerge.

What is the SWIS Suite? 
The SWIS Suite — a set of four 

applications (SWIS, CICO-SWIS, 

I-SWIS, and SAMI) — is a 

reliable, confidential, web-based 

information system built to 

collect, summarize, and use 

student behavior data for decision 

making. Research demonstrates 

that educators can make more 

effective and efficient decisions 

when they have the right data 

in the right format at the right 

HERE ’S A TI P
Some aspects of I-SWIS 
may be inaccessible based 
on your access level. Please 
contact your facilitator to 
have your access modified. 
For more information about 
access levels, see the 
support 
article on 
PBISApps.
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time. The SWIS Suite provides school/facility personnel with the 

information they need to be successful decision makers. 

What is I-SWIS?
I-SWIS is a decision system within the SWIS Suite for students 

receiving more intensive supports for academic, social, or mental 

health services. Teams using I-SWIS have a place to:

1.	 Identify team members

2.	 Store formal assessments

3.	 Update individual support plans

4.	 Assess the effectiveness of the interventions

With I-SWIS individual student support teams are organized, in-

formed, and able to make timely decisions to benefit each student.

Information entered into I-SWIS is confidential and secure. I-SWIS 

protects data through the use of account-specific passwords and 

high-quality data protection procedures. The SWIS Confidentiality 

and Security statement can be accessed at www.pbisapps.org.

About the QR Codes
The QR codes in this manual direct you to video tutorials or addi-

tional content as supplements to the written instructions. To use 

the QR codes you need a smart-

phone or tablet with internet 

access and software that can 

read and interpret the codes. 

There are many free QR code 

reader apps found in your 

device’s app store - for exam-

ple, the Apple App Store for 

iOS, Google Play for Android, 

or Windows Phone Store for 

Windows Phone. To download An example of a QR code.



6     I-SWIS User’s Manual

an app, search “QR code reader” in the app store on your device 

and download. 

All videos can be found on our website http://www.pbisapps.org 

by navigating to Resources > Video Tutorials in the main navigation.

Log In/Log Out

From your preferred internet browser (e.g.,Internet Explorer, Fire-

fox, Safari, Chrome) type in the website address www.pbisapps.

org to access PBIS Apps.

Once at PBIS Apps:

1.	 Click on PBIS Applications Login located in the black bar (app bar) at 
the top of the screen.

2.	 Enter the email address and password associated with the SWIS account.

3.	 Click Login. (If the password is a temporary password, a prompt appears 
for a permanent password to be created.)

The login is located in the black bar at the top of the screen.
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4.	 Once logged in, slide over to the left side of the app 
bar and click on SWIS Suite to access I-SWIS.

To log out of PBIS Apps and an I-SWIS account:

1.	 Click on the user’s email address located in the app 
bar at the top of the screen.

2.	 Click Logout.

Note: Users can also click on the Logout icon located in the blue 

bar at the top of the screen.

School Select Menu
Users with access to more than one school’s account see a menu 

displaying each school’s name. The School Select menu provides 

basic overview information without logging directly into the 

school’s account. 

Select School Menu Feature Overview
	� Search: Type the name of a school on your list to jump directly to that 

account.

	� Favorites List Filter: Click to display only schools marked as your favor-
ites.

	� DataLink Schools List Filter: Click to display only schools participating in 
DataLink to upload data.

	� Favorite: Click the star to mark the school as a favorite.

	� Info: Click to access additional information about the account.

	� Login: Click to login to the school’s account.

School Details Information Menu Feature Overview
	� School Information: See which applications the school accesses, the 

school’s grade range, and a full list of users along with their last login 
dates and times.

	� School Contact Information: View the schools mailing and physical 
addresses, phone number, and fax number.

Scan for video tutorial 
For instructions see page 5
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	� SWIS Information: Access the SWIS contact’s name and email, SWIS 
facilitator’s name and contact information, and see whether the school 
uses the SWIS Person Import feature.

	� DataLink Information: This section provides information about whether 
the school uploads data using DataLink and what the latest upload file 
contained.

Switch Schools
Users with access to more than one school can switch schools 

without logging out of SWIS. Note: Users with access to a single 

school’s account will not have access to this feature in the Tools menu.

1.	 Once logged in and inside the SWIS Suite, click Tools.

2.	 Click Switch School.

3.	 Select the desired school from the drop-down menu.

4.	 Click OK.

Quick Start
Create a New Student File

1.	 In I-SWIS Main, click New. 

2.	 Choose the student’s name 
from the drop-down list. 

3.	 Select the date the student’s 
plan started, or the first date 
data was/will be collected.

4.	 (Optional) Enter any notes 
about the student file for historical purposes. 

5.	 Click Save. 

Add a New Team Member
From the Student File Dashboard,

1.	 Click Team Members.

HERE ’S A TI P
If the student to add is new 
to the school, click the Not 
In List icon and follow the 
steps for adding a student 
on page 40 in this manual.
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2.	 Click the Add icon.

3.	 Select the correct Person Type from the drop-down menu.

4.	 Select the team member by name from the drop-down list. 

5.	 Type the team member’s role on the team in the Team Member Role 
field. Note: The Team Member Role is specific to the relation-

ship or support tasks related to the identified student. This is 

not necessarily the person’s position title.

6.	 From the Access Level drop-down menu, select the access the team 
member will have to the student’s file.

7.	 Click Save to save the new team member. Click Save & New to save the 
team member and enter another. 

a.	 If assigning the team member access, enter a temporary password 
for the team member’s login information in the Temp Password field.

b.	 Re-enter the temporary password in the Confirm Temp Password field.

c.	 Click Save.

Add a Measure
From the Student Dashboard:

1.	 Click Measures.

2.	 Click Add. 

3.	 Select a type from the Mea-
sure Type drop-down menu.

4.	 Type a name for the measure.

5.	 Type a start date or select the start date using the calendar icon.

6.	 Select a Metric Type from the drop-down menu.

7.	 Click Add in Data Collection Schedule and select a weekly or monthly 
schedule for data collection.

8.	 Click OK to save the schedule.

9.	 Click Add in Goals and enter the set goal for the measure.

HERE ’S A TI P
For more information 
about metric types and 
optional time segments, 
see page 20.
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10.	Click Ok to save the goal.

11.	 Click Save to save the measure. Click Save & New to save the measure 
and add another. 

View Reports
To access the School-Wide Report:

1.	 Click I-SWIS Main.

2.	 Click School-Wide Reports.

3.	 (Optional) Click Refresh Report at any time to update with new data entered.

I-SWIS Main 
The main page of I-SWIS contains a list of student files available in 

I-SWIS. By default, the student file list includes both active and 

inactive student files. This list can be modified based on search/

filter criteria and information about the status of the student’s 

record. User access to student information will vary.

Clicking once on a name from the Student Files list displays sum-

mary and history information for the selected record. 

Open Student File
To open a student file in  

I-SWIS:

1.	 Click I-SWIS Main.

2.	 Locate the student file to open 
from the list.

3.	 Double-click the  
student’s name.

Create a New Student File
From I-SWIS Main:

1.	 Click New. 

HERE ’S A TI P
If a padlock icon is displayed 
to the left of the student 
name, the file is one you 
cannot access. Contact 
your I-SWIS coordinator for 
additional access.
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2.	 Choose the student’s name from the drop-down list. 

3.	 Select the date the student’s plan started, or the first date data was/will 
be collected.

4.	 (Optional) Enter any notes about the student file for historical purposes. 

5.	 Click Save. 

Note: New student files default to an implementation status of 

Starting. Modify the student’s implementation status as needed.

Update a Student File Status
From I-SWIS Main: 

1.	 Right-click the student name from the list of enrolled students. 

2.	 Click Set Status. 

3.	 Choose the appropriate status from the drop-down menu. 

a.	 Active: The student is currently enrolled in the school and data may 
be entered for the student at any time.

b.	 Inactive: The student is no longer enrolled in the school, but may 
possibly return (e.g., transfer students).

The ISIS Main Dashboard
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c.	 Archived: The student is no longer enrolled in the school and is 
unlikely to return (e.g., graduated students).

Delete a Student File 
From I-SWIS Main:

1.	 Click to select the student’s name. 

2.	 Click Delete.

3.	 Click Delete to confirm. Click Cancel to return to I-SWIS Main.

4.	 If data exist in the student file, click Yes, Delete the Data to confirm the 
deletion. Click Cancel to return to I-SWIS Main.

5.	 Enter a deletion date and optionally notes related to the deletion. Click 
Cancel to return to I-SWIS Main.

6.	 Click Yes, Delete the Student File to confirm the deletion. Click Cancel to 
return to I-SWIS Main.

Student File
I-SWIS Coordinators create and manage student files, but may 

assign specific tasks and access to others on the team.

HERE ’S A TI P
Students in I-SWIS may fall in one of five implementation status cate-
gories. As the status changes, be sure to reflect the change within the 
student’s file in I-SWIS.

1.	 Starting: The student’s support plan is in early stages

2.	 Progressing: The student’s support plan is in place and student 
is making progress

3.	 Not Progressing: The student’s support plan is in place but 
student is not making progress

4.	 Needs Revision: The student’s support plan needs to be revised

5.	 Discontinued: The student’s support plan has been discontinued



I-SWIS User’s Manual     13

Dashboard
To access the Student File Dashboard, double-click a name listed 

in I-SWIS Main. 

The Dashboard contains a snapshot of the student file organized 

around four areas 

	� Summary

	� Measures

	� Documents

	� Team Members

	� The student’s name and co-
ordinator name are displayed 
in the upper left-hand corner 
of the dashboard. The student 
file start-date and the ability to 
modify it is in the upper right-
hand corner of the dashboard. 

Student File Summary
The Student File Summary is located on the Student File Dash-

board and provides information related to the most recent data 

entry date, implementation status, and documentation available 

for review.

The Student File Dashboard.
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Assessments/BSP/Documents
Coordinators and full-access users can upload and store docu-

ments related to each student file in I-SWIS. Each document can 

be downloaded for reference as teams make decisions about the 

student’s support plan.

View Documents
A full list of student file documents is visible from the Student 

File Dashboard. Here, each document is listed by name, type of 

document, and the date the document was added.

To view additional information about any document, from the 

Student File Dashboard, click Assessments/BSP/Documents. 

Here, documents are listed by name, type, version number, and date 

added. The list can be sorted by 

clicking on any column header. 

Add a Document
From the Student  

File Dashboard:

1.	 Click Assessments/ 
BSP/Documents.

2.	 Click Add. 

HERE ’S A TI P
When naming a document, 
it should be clear enough 
to easily identify the doc-
ument, but generic if you 
plan to upload additional 
versions later.

The Student File > Assessment/BSP/Documents tab.
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3.	 Type a title for the document in the Title field. 

4.	 Click on Browse button next to the File field to locate the electronic file 
to be uploaded. 

5.	 Select the type of file you are adding from the Type drop-down menu. 

6.	 Click Save. 

Add a New Document Version

As modifications occur to any document, a new version of the 

document can be uploaded into I-SWIS. Uploading a new version 

maintains the document’s history. 

From the Student  

File Dashboard:

1.	 Click Assessments/ 
BSP/Documents.

2.	 Click to select a file. 

3.	 Click Add Version. 

4.	 Click the Browse button next 
to the File field to locate the 
electronic file to be uploaded. 

5.	 Click Save. The new version  
appears at the top of the  
version list on the right side  
of the Document list. 

Edit a Document
As modifications occur to any document, edit the master copy and 

upload it to replace the current file. The title and the document 

type can also be edited.

From the Student File Dashboard:

1.	 Click Assessments/BSP/Documents.

2.	 Click to select the file to be updated. 

HERE ’S A TI P
Document management 
procedures should be 
determined before up-
loading files into I-SWIS. It 
is recommended to save 
master copies on a single 
team member’s comput-
er, shared drive, or other 
secure location. Identify 
a single person to make 
edits or updates to master 
files and to upload files into 
I-SWIS.
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3.	 Click Edit. 

4.	 Modify the Title, File, or Document Type as needed. 

5.	 Click Save. 

Delete a Document
From the Student File Dashboard:

1.	 Click Assessments/BSP/Documents.

2.	 Click to select the file to be removed. 

3.	 Click Delete. 

4.	 Click Delete to confirm the deletion. Click Cancel to return to the docu-
ment list.

Available Document Templates
Three templates for common document types are available at the 

bottom of the Assessment/BSP/Document tab. 

	� Behavior Support Plan

	� FACTS

	� Support Team Plan

Click any template to download a copy. Schools/facilities need 

not use the templates provided within I-SWIS if local alternatives 

are available.

Measures
Measures within I-SWIS are set up to monitor the fidelity of im-

plementation and student progress as identified within a student’s 

support plan. Measures establish the data entry screen and data 

entry schedule.

There are two types of measures to select from when establishing 

measures for each student file:

1.	 Fidelity: Fidelity measures monitor the level at which staff implement 
the student support plan. Each student file requires collecting at least 
one fidelity measure. 
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2.	 Outcome: Outcome measures monitor the impact of the support plan 
on the student’s academic or social behavior. Each student file requires 
at least one outcome measure.

View Measures
The Student File Dashboard displays all measures associated with 

the student plan. For more information on each measure, click 

Measures from the Student File Dashboard.

The Measure tab displays both active and inactive student mea-

sures. Filter the list to include active, inactive and/or archived 

measures by selecting or unselecting the filter from the Measures 

tab. Sort the list by clicking on any column header. 

Update a Measure Status
As the student’s plan changes, updates to individual measures 

will need to be updated. There are three statuses available for each 

measure associated with a student file:

	� Active: Data are currently collected.

	� Inactive: Data are not collected at this time.

	� Archived: The measure has been discontinued.

To update a measure’s status, from the Student Dashboard:

1.	 Click Measures.

The Student File > Measures tab.
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2.	 Right-click the measure to be updated. 

3.	 Choose Set Status. 

4.	 Select the correct status. 

5.	 If inactive or archived: Type the measure’s end date or select one from 
the calendar icon.

6.	 Click Ok to update the status. Click Cancel to return to the Measures tab.

Add a New Measure
From the Student Dashboard:

1.	 Click Measures.

2.	 Click Add. 

3.	 Select a type from the Mea-
sure Type drop-down menu.

4.	 Type a name for the measure.

5.	 Type a start date or select the 
start date using the calendar icon.

6.	 Select a Metric Type from the 
drop-down menu.

7.	 Click Add in Data Collection 
Schedule and select a weekly 
or monthly schedule for data collection.

8.	 Click OK to save the schedule.

9.	 Click Add in Goals and enter the set goal for the measure.

10.	Click Ok to save the goal.

11.	 Click Save to save the measure or click Save & New to save the mea-
sure and add another. 

HERE ’S A TI P
Once data have been saved 
to an I-SWIS measure, 
the Metric Type cannot be 
modified. It is important to 
carefully review measures 
shortly after set-up to  
ensure the measures fit 
data entry, reporting, and 
decision-making needs
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Basic Information

	� Measure Name: A short, 
descriptive title of what you 
want to measure (e.g., Rate of 
Disrespect).

	� Description: A description  
detailing what you want to 
know, how you will measure  
it, and how often.

	� Start Date: The earliest date 
for data collection to begin. 

Metric Type
The Metric Type identifies how data will be collected and summa-

rized. Below is a list of how data will be entered given the metric 

type chosen.

	� Percent: Enter percent values between 0-100%.

	� Calculated 
Percent: Enter 
# of attempts 
/ # of possible 
attempts. I-SWIS 
calculates the 
percent.

	� Point/Count/
Duration: Enter # 
of points, count 
of something, or 
duration of event 
for each time 
segment.

	� Scale: Enter a number based on the established scale. 

	� Rate: Enter the number of times the behavior is observed per length of time.

HERE ’S A TI P
The Student File Set-Up Checklist contains 
a metric set-up worksheet for how to use 
each metric type. Explore the I-SWIS 
Demo account and 
practice in your 
I-SWIS facilitator’s 
account for examples 
within the application.

HERE ’S A TI P
The Data Collection Schedule 
start date as well as the 
Goals start date default to 
the measure’s Start Date. 
The measure’s Start Date 
cannot pre-date the  
Student File Start Date.
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Metric Type Examples

Metric Type Example A Example B

Percent
What percentage of  
math problems did Matt 
complete each day?

What percentage of the 
class period did Jason 
complete without a  
disruptive outburst?

Calculated 
Percent

How many times did 
Emily use her “ask the 
teacher a question” skill 
out of four opportunities?

Out of five possible,  
how many periods did 
Lizbet arrive on time?

Point/
Count/ 

Duration

Ben will earn two points 
each time he shares with a 
peer. Record the number 
of points earned per day.

Record the number of 
minutes it takes Emile 
from ending lunch to 
initiating instruction.

Scale

Enter the extent to which 
we believe we have  
implemented Megan’s 
plan with fidelity on a 
scale from 1 = low, to  
5 = high

Measure Jace’s temper-
ament on a scale from 
1 = disturbed, 2 = mild 
agitation, 3 = calm, 4 = 
engaged, and 5 = happy

Rate

Record the median number 
of words read correctly 
per min during literacy 
progress monitoring. 

Record the number of 
Emmitt’s social initiations 
per number of minutes  
at recess.

Time Segments (optional)
Adding time segments allows the option for collecting data across 

multiple periods. This is an optional component for adding measures.

To use time segments for a measure, check the Use Time Segments 
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box in the Time Segments section of the Add Measure workspace. 

Uncheck the box to opt out of time segments for the measure.

Data Collection Schedules
The Data Collection Schedule establishes when the data are to 

be entered in I-SWIS. A Student File should contain one or more 

Data Collection Schedules. Teams may opt to collect data using an 

ad hoc schedule as needed.

	� Ad Hoc: Allows data entry as needed in addition to any established data 
collection schedule. 

	� Start Date: The earliest date for data collection to begin. 

	� End Date (optional): The last date for data collection using this schedule.

	� Weekly: Data collection occurs on a weekly schedule. Check the boxes 
next to the appropriate weekdays or utilize the quick selections: week-
days, all, none. 

	� Monthly: Data collection occurs on a monthly schedule based on a day 
or week of the month. 

Goals
Measure goals entered in I-SWIS are based on criteria identified 

within the student’s plan, benchmarks, and/or team agreements. 

I-SWIS allows one goal at a time per measure. 

	� Operator: The comparative 
indicator of performance  
(e.g., greater than >, less than 
or equal to ≤).

	� Target: Numerical criteria of 
performance. 

	� Start Date: The earliest date 
the goal was implemented or 
monitored. 

	� End Date: The last date the goal 
was implemented or monitored. 

HERE ’S A TI P
To track a student’s goal 
history, use the start and 
end dates as the goal 
changes. Using start and 
end dates, the goal line 
stair-steps to show how the 
goal shifted across time.
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	� Notes: Additional information about this goal. 

Edit a Measure
From the Student Dashboard:

1.	 Click Measures.

2.	 Double-click the measure to edit.

3.	 Edit the following information as needed:

a.	 Basic Information

b.	 Metric (if no data have been entered and saved

c.	 Time Segments

d.	 Data Collection

e.	 Goals 

4.	 Click Save to save the changes. Click Cancel to return to the  
Measures tab. 

Delete a Measure
Measures should be deleted only if the measure was set up incorrectly, 

and/or if the team has determined that this measure was not  

HERE ’S A TI P
Editing some information will not have an impact on previously 
entered data.

Time Segments: Editing the Time Segments of a Measure does not 
change previously saved data. Previous data will use the old time 
segments. Future data will be entered using the new Time Segments. 

Data Collection Schedule: Editing the Data Collection Schedule(s) 
does not change previously entered data. To maintain a history of 
Data Collection Schedules, enter an End Date into the old schedule, 
and then add a new schedule to start on the appropriate date. 
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appropriate and should not be included in the student’s case history. 

1.	 In the Measures tab, click to select the measure to be removed. 

2.	 Click Delete. 

3.	 Click Yes, Delete the Data to confirm the deletion. Click Cancel to return 
to the Measures tab.

Team Members
For each student file, coordinators organize team members, assign 

team member access, and communicate with team members by email. 

View Team Members
A full list of team members is 

visible from the Student File 

Dashboard. This view lists 

each team member by name 

along with type, team role, and 

access level displayed. 

To view additional information 

about Team Members, from the 

Student File Dashboard, click 

Team Members. 

This view lists team members 

The Student File > Team Members tab.

HERE ’S A TI P
While all student team 
members should be listed 
for each file, not all team 
members will have the 
same access to student file 
information. Team members 
may have full access, data 
entry access, read-only 
access, or no access to 
individual student files.
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by name along with team role, access level, email address, and 

type. Sort the list by clicking any column header. 

Add a Team Member
From the Student File Dashboard:

1.	 Click Team Members.

2.	 Click the Add icon.

3.	 Select the correct Person Type 
from the drop-down menu.

4.	 Select the team member by 
name from the drop-down list. 

5.	 Type the team member’s 
role on the team in the Team 
Member Role field.  
Note: The Team Member Role 
is specific to the relationship 
or support tasks related to 
the identified student. This is 
not necessarily the person’s 
position title.

6.	 From the Access Level drop-down menu, select the access the team 
member will have to the student’s file.

7.	 Click Save to save the new team member. Click Save & New to save the 
team member and enter another. 

a.	 If assigning the team member access, enter a temporary password 
for the team member’s login information in the Temp Password field.

b.	 Re-enter the temporary password in the Confirm Temp Password field.

c.	 Click Ok.

Edit a Team Member Role or Access Level
As team member information changes, updates can be made di-

rectly within I-SWIS. From the Student File Dashboard:

1.	 Click Team Members.

HERE ’S A TI P
Access should be assigned 
to team members with 
specific tasks related to 
entering data, generating 
reports, and/or assisting 
the coordinator in Student 
File management. In general, 
non-staff team members 
should be given “No Access” 
to ISIS-SWIS.
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2.	 Double-click the name of the team member to edit.

3.	 Modify the team member’s role or access level. 

4.	 Click Save. 

Remove a Team Member
From the Student File Dashboard:

1.	 Click Team Members.

2.	 Click to select the team  
member to remove.

3.	 Click Remove.

4.	 Click Remove to confirm the 
removal. Click Cancel to return 
to the Team Member tab. 

Note: Removing a team member in I-SWIS removes the team 

member from, and his/her access to, the student file. The team 

member’s name remains on the related student/staff/non-staff 

roster. All data associated with the team member remains in the 

application. 

Send a Team Email
From the Student File Dashboard:

1.	 Click Team Members.

2.	 Click Email Team to open an email to all team members in your default 
email program.

3.	 Click any team member’s individual email address to open an email to 
that team member using your default email program. 

Assign a New Coordinator
I-SWIS coordinators may transfer management responsibilities for one 

or more student files to another I-SWIS coordinator either temporarily or 

permanently. Each student file must be assigned to a coordinator. 

Only transfer Student Files with the new coordinator’s permission. 

HERE ’S A TI P
Use Person Management 
to edit a team member’s 
name, type, or email 
address. See page 41 for 
more information.
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From the Student File Dashboard:

1.	 Click Team Members.

2.	 Click Assign Coordinator. 

3.	 Select a coordinator from the list of identified coordinators. 

4.	 Click Assign. 

Note: I-SWIS facilitators setup coordinators. After clicking  

Assign Coordinator, if a message appears stating there are no  

active coordinators, contact your facilitator and ask to have the 

new coordinator entered.

Data Entry 
Data Entry is based on the measures set up for the individual 

student file. Please use the Data Entry Workspace screenshot to 

identify the location of each corresponding step in the I-SWIS 

Data Entry workspace.

Enter Measure Data
From I-SWIS Main

1.	 Double-click the student’s name from the Student File list (not shown in 
screenshot). 

2.	 From the Student Dashboard, click on Data Entry. 

3.	 Use the Calendar to select the appropriate data entry date as needed. 
(Today is selected by default.)

4.	 Set the student’s status for the day using the Student Status drop-down 
menu. (Present is selected by default.)

5.	 Set the student’s status for the measure using the Student Status drop-
down within the appropriate measure. (Present is selected by default.)

6.	 Enter scheduled measure data as indicated in I-SWIS. 

7.	 Optional data to enter:

a.	 Ad hoc data: Click on the Ad hoc button to the right of the measure name. 
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b.	 Notes by day: Click the Notes icon next to the day’s Student Status 
drop-down menu.

c.	 Notes by measure: Click the Notes icon to the right of the measure’s 
Student Status drop-down menu.

d.	 Support Plan Change: Type the change in the Support Plan Change field. 

8.	 Click Save. 

View Reports
Data collected in I-SWIS are available for review within the Re-

ports section. Tailor reports for efficient, effective decision mak-

ing.

School-Wide Reports
The School-Wide Report is available from I-SWIS Main. The 

report displays information about the overall implementation of 

Tier III supports monitored across the SWIS Suite. User access to 

the School-Wide Report will vary. 

The Data Entry Workspace. Numbers included  
correspond to the steps outlined in Enter Measure Data.

4
3

5

6

7a

7c

7b

7d

8
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The School-Wide Report has three sections:

	� School Year: This section contains a summary of student data collected 
across the SWIS Suite for the current school year.

	� Current: This section contains a current snapshot of  todays’ student data.

	� Student Status: This section lists the students who have I-SWIS files 
within the current school year. The list can be filtered by the file status 
(active, inactive, archived). The list can be sorted by clicking any of the 
column headers. 

To access the School-Wide Report:

1.	 Click I-SWIS Main.

2.	 Click School-Wide Reports.

3.	 (Optional) Click Refresh Report at any time to update with new  
data entered.

Example of the School-Wide Report.



I-SWIS User’s Manual     29

Student File Reports
Three types of reports are available within each student file de-

pending on the measure types used. 

	� Measure: Report information 
about a student’s fidelity and 
outcome measures per day. The 
options to report two measures 
together and display SWIS 
referral data are available.

	� Time Segments: For measures 
set up with time segments, 

report the average or total score 
entered across segments.

	� Single Time Segment: For 
measures set up with time seg-
ments, report all data entered 
for a specific segment.

Note: If Time Segments are not used within a student’s plan, Time 

Segment and Single Time Segment reports cannot be generated.

Example of the Measure Report
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Generate a Measure Report 
From I-SWIS Main:

1.	 Double-click a student name 
from the Student File list. 

2.	 Click on View Reports. 

3.	 Click Measure.

4.	 In the Options panel on the 
left, identify the following: 

a.	 Start: Earliest date from which the report displays data. 

b.	 End: Latest date from which the report displays data. 

c.	 Primary Measure: The measure to be reported. 

d.	 Comparative Measure: Additional data to be reported for comparison. 

e.	 Additional information: Check any of the boxes to display/not dis-
play any of the following information on the report

	� Student Name

	� Goal Lines

	� Support Plan Changes

	� Notes 

5.	 Click Generate.

Generate a Student Time Segment Report
From I-SWIS Main:

1.	 Double-click a student name from the Student File list.

2.	 Click View Reports.

3.	 Click Time Segment. 

4.	 In the Options panel on the left, identify the following: 

a.	 Start: Earliest date from which the report displays data. 

b.	 End: Latest date from which the report displays data. 

HERE ’S A TI P
It is recommended to review 
fidelity measure data as a 
comparison with outcome 
measure data to identify any 
correlation between the two.
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c.	 Primary Measure: The measure to be reported. 

d.	 Show Student Name: Check the Student Name box to include the 
student name on the report. Uncheck it to hide the information.

e.	 Include “No School” in Max Scheduled Days: Check the Include 
No School days box to include all days entered as No School in the 
count of days with possible points. Uncheck the box to exclude No 
School days from the count.

5.	 Click Generate.

Generate a Student Single Time Segment Report
From I-SWIS Main:

1.	 Double-click a student name from the Student File list.

2.	 Click View Reports.

3.	 Click Single Time Segment. 

4.	 In the Options panel on the left, identify the following: 

a.	 Start: Earliest date from which the report displays data. 

b.	 End: Latest date from which the report displays data. 

c.	 Primary Measure: The measure data to be reported. 

d.	 Time Segment: The specific time segment to be reported. 

e.	 Comparative Measure: Additional data to be reported for compar-
ison. Note: Comparative data are not specific to the time segment 
selected in the Primary Measure.

f.	 Additional information: Check any of the boxes to display/not dis-
play any of the following information on the report:

	� Student Name

	� Goal Lines

	� Support Plan Changes

	� Notes 

5.	 Click Generate.
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Tools – Account Settings
Account Settings allow an individual user to update personal profile 

information and update personalized application settings to ac-

commodate data entry or reporting preferences. An account’s  

settings are stored individually for each password accessing I-SWIS, 

allowing each user to customize I-SWIS for individual usage. 

To access Account Settings: 

1.	 Click Tools.

2.	 Click Account Settings. 

Within the Account Settings menu, schools/ 

facilities can view and modify information related 

to Account Profile and SWIS Suite Applications.

Account Profile
Account Profile Settings allow a user to verify and update name, 

contact email, username, password, or avatar. 

1.	 To modify Account Profile Settings, in Account Settings:

2.	 Click on Profile under Account Profile.

3.	 Click the name of the section to edit.

4.	 Type the new information to modify Account Profile information.

5.	 Enter your current password for changes to take effect.

6.	 Click Save.

Applications - General
Applications settings allow users to enable specific settings ac-

cording to personal preference. General settings include: 

	� Locale

	� Name Sort Order  
(First Last vs Last First) 

	� Default Graph Size

Scan for video tutorial 
For instructions see page 5
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To modify General settings, in Account Settings: 

1.	 Click on General under Applications.

2.	 Select the setting to modify.

3.	 Type or select the preferred option for the setting.

4.	 Click Save.

Tools – School Settings
To access School Settings:

1.	 From I-SWIS Main, click Tools.

2.	 Click School Settings.

Within the School Settings menu, 

schools/facilities can view and modify information related to:

	� School Profile

	� Core Data 

	� General and Application- 
Specific Settings

	� Data Integrity Settings

The School Profile includes all physical and contact information 

for the school/facility. Any of the information provided in this 

section can be updated with the exception of the District Name:

	� District Name 

	� School Name 

	� Mailing Address

	� Physical Address

	� Grade Range 

	� Phone Number 

	� Fax Number

School Profile – Contact Information
Contact information for the following roles can be located and/or 

edited as changes occur.

	� Admin Contact 	� Billing Contact

Core Data – School Days
To enter or modify School Days, from School Settings: 

HERE ’S A TI P
School Settings are 
set for the entire 
school and will be 
the same for all users.
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1.	 Click School Days under Core Data.

2.	 Click on the school year to expand the menu.

3.	 Type or select the number of schools days for each calendar month 
(Early release days count as one full day).

4.	 Click Save.

Core Data – School Enrollment
To enter or modify School  

Enrollment, in School Settings: 

1.	 Click on School Enrollment.

2.	 Click on the correct school 
year to expand the menu.

3.	 Enter the total enrollment.

4.	 If the school/facility collects 
additional student demo-
graphic data (Race/Ethnicity, 
Gender, IEP, and/or English 
Learner information): Enter 
the number of students within 
each subgroup. Total enroll-
ment calculates automatically based on the subgroup enrollments entered.  

5.	 Click Save.

Note: In order to generate the School-Wide Reports, I-SWIS re-

quires details about School Enrollment.

Applications - General 
To enter or modify General Settings, in School Settings: 

1.	 Click General. 

2.	 Click anywhere within the row of the appropriate field to expand the menu. 

3.	 Choose Yes to enable the identified feature. 

4.	 Choose No to disable the feature. 

HERE ’S A TI P
Enrollment data should 
be entered at the same 
time as the annual census 
count (typically by October 
1st). Enrollment totals only 
change during a school 
year if a large (10-20%) 
change in enrollment 
occurs mid-year.
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5.	 Click Save. 

6.	 Close School Settings by clicking on the red X icon in the upper right 
corner of the screen.

Start Month
Default: August

This setting sets which month is considered the start of the year 

for reporting and decision-making purposes. 

To modify the Start Month: 

1.	 Select the appropriate month from the drop-down menu. 

2.	 Click Save. 

Use 504
Default: Enabled 

Schools/Facilities may opt to collect data about individual students’ 

504 status.

To disable this feature:

1.	 Select No from the drop-down menu.

2.	 Click Save

The School Settings > Core Data > School Enrollment settings.
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Use Ethnicity
Default: Enabled

When Use Ethnicity is enabled, the SWIS Suite will require race/

ethnicity data to be entered. To disable ethnicity as a required 

field, in School Settings:

1.	 Select No from the drop-down menu.

2.	 Click Save.

For more information about entering individual student ethnicity 

and race information, please refer to the Person Management  

section on page 38.

Risk Ratio Comparison Group
Default: All Other Groups

When generating the Risk Ratio graph in the Equity Report, the 

risk index for a group will be compared to the risk index for the 

comparison group selected in this preference. Schools may select 

a different comparison group representing the majority group and 

dominant culture in the building.

HERE ’S A TI P
The federal government requires schools, districts, and states to collect 
individual-level race and ethnicity data and report aggregated data in 
the following ways:

	� Individual students must report both their ethnicity as well as 
race.

	� Students may identify more than one race.

	� Multi-Racial is listed only as a category for aggregate  
reporting purposes.
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Note: Schools select a comparison group for student groups with 

more than 2 subgroups identified. This setting is available in the 

Use Race/Ethnicity and Use Additional Gender Options settings.

Use English Learner
Default: Disabled

When enabled, users can identify each student’s English Learner 

status. To enable this setting:

1.	 Select Yes from the drop-down menu.

2.	 Click Save. 

Use IEP
Default: Enabled 

When enabled, users will identify each student’s IEP status and 

disability category. To disable this setting: 

1.	 Select No from the drop-down menu.

2.	 Click Save.

Use Additional Gender Options
Default: Disabled

When enabled, users select one of three options for a student’s 

identified gender:

	� Male

	� Female

	� Non-Binary/Transgender/Other Gender

When disabled, there are only two gender options available for 

selection (Male and Female). Once enabled, users cannot disable 

this setting. To enable this setting:

1.	 Select Yes from the drop-down menu.

2.	 Click Save.
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Use Person Import
Default: Disabled 

When enabled, users have the ability to import student and staff 

lists directly into SWIS. To enable this setting: 

1.	 Select Yes from the drop-down menu. 2.	 Click Save.

Require Staff and Require Student District IDs
Staff District ID Default: Enabled 

Student District ID Default: Enabled

The SWIS Suite allows the school/facility to utilize district/internal 

identification numbers for staff in addition to the SWIS assigned 

ID number. If disabled, the staff and/or student SWIS ids are displayed 

on reports. To disable this feature:

1.	 Select No from the drop-down menu. 2.	 Click Save.

Other – Data Integrity Settings
The Data Integrity system alerts of any possible data errors within 

the SWIS Suite. Errors identified within your account are based 

upon the settings established in the Data Integrity School Settings. 

To set settings for the Data Integrity system, in School Settings:

1.	 Click on Data Integrity under Other.

2.	 Check the box to the left of the record type to enable a check within the 
system. Unchecked record types will be ignored for data integrity errors.

3.	 Select a date from any of the calendar icons to choose a date before 
which specific record types will be ignored.

4.	 Click Save.

Tools – Person Management
Person Management allows schools/facilities to organize students, 

staff, and non-staff records associated with SWIS Suite data. 
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To access Person Management:

1.	 Click Tools.

2.	 Under the Person Management header, select the 
appropriate list  
(Student, Staff, Non-Staff) to review or modify.

Note: Person Management is also located in the 

top right-hand corner of the application next to the Logout icon.

Within Person Management, only records with a status matching 

the selected filters will be displayed. The filters Active, Inactive, 

and Archived can be checked and unchecked to display or hide a 

name from the list. 

	� To see all currently active person records, check only the Active box 
from the filters. The first 15 active records display in the result set. 

	� Use the navigation at the bottom of the screen to tab through the list 
and view additional records. 

	� Click on a name to display the person’s information to the right of the list. 

The Person Management workspace.

Scan for video tutorial 
For instructions see page 5
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Add a New Record

1.	 In the Tools menu, click 
Person Management.

2.	 Click on the correct tab: 
Students, Staff, Non-Staff. 

3.	 Click Add.

4.	 Enter all required informa-
tion about the person. 

5.	 Click Save to save or click OK 
and New to save and open 
a new form to continue 
adding new person records.

Merge Duplicate Records
Merging two names will move all data from the “Student/Staff/

Non-Staff to Delete” to the “Student/Staff/Non-Staff to Retain.”

1.	 Check the Active, Inactive, and Archived filter boxes to display all person 
records associated with the account.

2.	 Locate the name 
of the person to 
be retained by 
typing the name 
in the Search 
field. 

3.	 Click the Search 
icon.

4.	 Click to select 
the name of the 
record to retain.

5.	 Click Merge. 

6.	 In the Student/Staff/Non-Staff to Delete field type the name of the 
person record to delete. All data from this record will be moved to the 
Student/Staff/Non-Staff record chosen to be retained.

The Edit Student workspace.

HERE ’S A TI P
For students on an IEP, a disabil-
ity category must be selected. 
“To Be Obtained” should only be 
selected when a record urgently 
needs to be recorded but the disability 
category is not available. It is 
critical to update this information 
to keep records current for  
reporting and decision making.
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7.	 Click to select the name of the record to delete.

8.	 Click Merge.

Revise a Record

1.	 In the Search field, type name of the record to modify. 

2.	 Click the Search icon.

3.	 In the result set, double click on the record to revise. 

4.	 Revise the necessary information.

5.	 Click Save.

Delete a Record

1.	 Type the name of the record to 
be deleted in the Search field. 

2.	 Click the Search icon.

3.	 Click to select the record to delete.

4.	 Click the Delete button.

5.	 Click Delete to confirm. Click 
Cancel to return to the roster.

Update a Record Status

1.	 Check the Active, Inactive, and 
Archived filter boxes to display all persons associated with the SWIS 
account.

2.	 Type the name of the record to update in the Search field. Click the 
search icon.

3.	 Right-click on the record and select Set Status. Select the appropriate 
status for the record:

	� Active: the person is currently associated with the school.

	� Inactive: the person is not currently associated with the school, but 
may return (e.g., transfer students).

HERE ’S A TI P
The SWIS Suite prevents 
deleting person records 
attached to data. If there 
are duplicate person re-
cords and each has data, 
merging the two records 
is recommended over 
deleting.
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	� Archived: the 
person is not cur-
rently associated 
with the school and 
will not be return-
ing (e.g., graduated 
students).

	� Click OK.

Update Multiple Re-
cords
Multiple person re-

cords may be selected within the same page to update to the same 

status all at once. To update multiple records with one click:

1.	 When the Person Management list opens, scroll to the page with multi-
ple records to update.

2.	 Check the box to the left of each record to update.

3.	 Click the Set Status button located at the top of the list.

4.	 Select the appropriate status for the records.

Tools – Data 
Data Integrity
To access the Data Integrity system:

1.	 From I-SWIS Main, click Tools.

2.	 Click Data Integrity.

The summary at the top of the report identifies the number of 

possible errors within the account in each record type. Below 

the Summary are two columns. Good data lists the record types 

without identified errors. Problematic Data lists each record type 

with an itemized list of possible errors. The full report checks for 

the following:

	� Any staff, non-staff, or students 
missing district ids

	� Duplicate staff, non-staff, or 
student records

The Person Management workspace with Set Status menu.

Scan for video tutorial 
For instructions see page 5
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	� Staff, non-staff, or students with 
duplicate district ids

	� Duplicate referrals 

	� Referrals out of date range 
(referrals before 1997 or with 
future dates)

	� Referrals out of time range 
(based on the Time Range 
setting established in School 
Settings)

	� Referrals with Action Pending 
marked as the Action Taken

	� Referrals with a major/minor 
behavior mismatch

	� Missing or incomplete School 
Days data

	� School Days data out of range 
(months with more days than 
possible weekdays)

	� Missing/Incomplete School 
Enrollment data

	� School Enrollment data out of 
range (greater than 2500 students)

	� Students with a Disability Cate-
gory marked as To be Obtained

	� Students on an IEP with no 
Disability identified

	� Inactive/Archived students 
enrolled in CICO-SWIS

	� Inactive/Archived students in 
I-SWIS with open student files

To correct any of the records listed in Problematic Data:

1.	 Double-click the record to correct.

2.	 Correct the information.

3.	 Click Save.

Person Import
Person Import allows any SWIS Suite school to 

import a list of students or staff from a Student 

Information System into the SWIS application. 

Importing these records reduces the amount of time schools spend 

manually entering data already available in another system. 

Schools’ data must meet certain requirements to ensure a clean 

import of person records. These requirements ensure the import 

process is accurate without creating duplicate records. 

All schools utilizing Person Import must have:

Scan for video tutorial 
For instructions see page 5
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	� Student and staff district ids 
required in School Settings

	� All active and inactive students 
and staff identified with a 
district id. (The process ignores 
archived students and staff.)

	� All unique district ids. No two 
student records, no two staff 
records have the same district 
ids. 

	� The ability to generate an import file matching the required format.

Users with specific access to SWIS and/or CICO-SWIS can enable 

Person Import for the school. Users with access only I-SWIS can-

not enable this feature, but some may have access to the Person 

Import Dashboard.

Student Dashboard
The Student Dashboard provides school/facility personnel with 

a comprehensive report for an individual student with data in 

SWIS, CICO-SWIS, and/or I-SWIS. 

To access the Student Dashboard: 

1.	 Click Tools, then click Student Dashboard. 

2.	 Double-click the student record to select a student 
to view from the Select a Student list.

3.	 The Student Dashboard opens with data from the 
current school year.

4.	 Select another year from the drop-down menu located next to the stu-
dent’s name to display data from previous school years.

Note: CICO-SWIS data will not appear in the Student Dashboard 

when previous years are selected.

Scan for video tutorial 
For instructions see page 5

HERE ’S A TI P
Visit the Data Integration 
section of PBISApps.org for 
more information on the 
pros and cons related to  
Person Import.
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Student Dashboard reports include:

	� Summary

	� Latest Referrals—the student’s 
10 most recent referrals.

	� Referrals Per Year

	� Suspension/Expulsion

	� Referrals By Motivation

	� Referrals By Time

	� Referrals By Problem Behavior

	� Referrals By Location

	� Referrals By Day Of Week

	� Average Referrals Per  
Day Per Month

	� CICO-SWIS Individual Student 
Count (if your school uses 
CICO-SWIS and the student has 
data)

Tools - Support
As questions come up about how to use I-SWIS, it is recommend-

ed to refer to the PBISApps Support page for the answers. Access 

the Support page by clicking Support under the Tools menu. The 

PBISApps Support page will open in a new tab. Search the page 

for answers to your frequently asked questions.

Tools - Invoice Details
The status of any SWIS Suite subscription and associated invoice 

is available in the section labeled Invoice Details located in Tools. 

From this section, you can view, print, and pay the invoice(s) 

associated with the school’s subscription(s). 

View, Print, or Pay an Invoice

1.	 From the Tools menu, click Invoice Details.

2.	 A window appears with all possible applications listed along the top with 
their current subscription status.

	� Green + : Subscription is current and invoice is paid.

	� Yellow + ! : Subscription is due and invoice is unpaid.
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	� Red + ! : Subscription is more than 30 days past due and invoice  
is unpaid.

	� Gray + : No subscription

3.	 Click any of the invoice numbers listed on the left-hand side of the 
window to view a copy. Note: Only invoices from the current subscription 
year will display in this section.

4.	 Click Print to print a copy of the invoice.

5.	 Click Pay Invoice and the application opens a new window to the online 
portal to pay your invoice with a credit card.

HERE’S A TIP
A quick view of the subscription status is also available on any 
application’s dashboard. The notification’s color is an indication of the 
subscription’s status:

	� Yellow: Due

	� Red: More than 30 days past due

	� No Notification: Paid
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Tools – User Management
A list of people with access to a school’s SWIS Suite account is 

found in the User Management screen. To access User Manage-

ment, click Tools then User Management.

Click a user’s name to view additional details such as their:

	� Username

	� Access level to SWIS, CICO-SWIS or I-SWIS

	� Last time logging in to PBISApps

HERE’S A TIP
Hover your mouse over any column header in this screen to reveal 
an arrow. Click it to add columns to the default table view.



Appendix A - I-SWIS Data Entry  
and Reporting Schedule
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